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Huntron Workstation Oscilloscope Software Tutorial 

Huntron Workstation software 

It is very helpful if you have a working knowledge of Microsoft Windows prior to using 

Huntron Workstation. 

You are allowed to create a backup copy of the software disk. Your purchase 

agreement allows for copies to be made for backup purposes only- copying for 

distribution or resale is strictly prohibited.  

 

Installation Instructions 

Install the software BEFORE connecting any hardware. Uninstall any previous versions 

prior to loading the current version. For more installation details follow the “Getting 

Started” sheet included with your Huntron product. 

Uninstall any previous versions of Workstation prior to installing the new version. 

Insert the Huntron Workstation CDROM. The CDROM should Autorun and begin the 

installation process. If your PC has Autorun disabled then browse Window and select 

WorkstationSetup.exe. This will begin the installation process. During the install you 

will be asked to install additional software for Access Probers. Select the appropriate 

response based on your Prober hardware. 

 

Installation of Additional Support Software 

Installation of software for the support of supported oscilloscopes will be required for 

the proper operation and control. 

 

Keysight (Agilent) DSO1022A and DSO-X-2022A 

Insert the Keysight IO Libraries Suite CD or download the software from keysight.com. 

Run the IO Libraries Suite installer. The install process should begin. Use default 

selections as prompted during the installation process as there are no special 

conditions needed for the oscilloscope hardware. 

If the Agilent/Keysight DSO1022A is being used copy the “HuntronExternal3.dll” 

file from the path “C:\Program Files\Huntron Workstation\E3DSO1022A” to the path 

“C:\Program Files\Huntron Workstation”. Select “Yes” to overwrite the existing 

“HuntronExternal3.dll” file in that path. If the Keysight DS-X-2022A is being used 

then use the “HuntronExternal3.dll” file from the E3DSOX2022A folder. 
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Hardware Setup 

If a Huntron Access Prober is being used, connect it to power.  

Connect the Huntron Access to the PC with the USB Cable. 

Connect the oscilloscope to Power. 

Connect the oscilloscope to the PC using the USB cable. 

Using the “Installation of Oscilloscope Probe Mounting Kit” instructions, connect the 

oscilloscope to the Huntron Access by placing the oscilloscope probe into the probe 

adapter mounted to the Z axis rail as shown in the image below. 

 

 

A connection from the oscilloscope ground will need to be made to the UUT. 

 

Huntron Workstation Main Interface 

When starting Huntron Workstation for the first time, you will be prompted for an 

activation code. Type in the code exactly as it is presented on the installation CD. 

Use upper case letters and note the differences between the letter “O” and the number 

zero. 
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The Main Window for Huntron Workstation 4 features a multi-pane layout. The Panes 

are interactive to a certain degree in that changes in one Pane will affect other Panes. 

The Panes can be resized, floated independently or “tabbed” to the sides of the 

window. The Status Bar displays information about items currently selected and status 

information while processes are running.  

The Toolbar 

The Toolbar just under the application menus allows for quick access to several 

program functions. The function of each is broken out in the diagram below. 

 

 

 1. 2. 3. 4. 5. 6. 7.  8.  9. 10.  11. 12. 13. 14. 15. 16. 17. 18. 19. 

 

1. Create New Board database 11. Scan Component or Net 

2. Open Board database 12. Scan Sequence 

3.  Save As… 13. Send Prober head to Home position 

4. Add New (Sequence, Component or Range) 14. Connect/Disconnect Prober 

5. Copy (Sequence, Component, Net or Range) 15. Connect/Disconnect Tracker 

6. Paste (Sequence, Component, Net or Range) 16. Previous Component or Net 

7. Cut (Sequence, Component, Net or Range) 17. Next Component or Net  

8. Delete (Seq., Comp., Net, Range or Scan) 18. Previous Pin 

9. Build New (Sequence, Component) 19. Next Pin 

10. Repeat New (Sequence, Component) 

Tree Pane 
- Test and editing 

Signature Pane 
- Signature display 
and scanning 

Prober Pane 
- Robotic Prober 
control 

Image Pane 
- Display of CAD 
layout and PCB 
images 

Status bar 

Tool bars 



 

© Huntron, Inc 2016 Rev. B 6 

Hardware Setup 

Turn on the Huntron Access and the oscilloscope. Windows will detect New Hardware 

and install the driver needed to communicate with the oscilloscope. 

Agilent/Keysight Oscilloscope 

Go to the Windows START button, locate and start the Keysight Connection Expert 

application. Locate the connected oscilloscope by selecting your model in the 

Instruments tab (see image below). Note the serial number listed in the Instrument 

properties. 

 

 

 

After verifying that the instrument is properly connected, close the Keysight 

Connection Expert. 

When first starting Huntron Workstation, select Options from the Tools menu. The 

Options window is used to setup default settings used when working in Huntron 

Workstation.  
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Select the General tab and set the desired Unit of Measure (use Microns for Huntron 

Access Probers, Mils for any other Prober). Also Select Compare Depth of Range. 

 

Select the Hardware tab and leave the type of Tracker hardware, the Tracker Port 

and Scanner options at none. 
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If an Access Prober is being used you will need to select the type of Access Prober, the 

serial port for the Prober and the Frame Grabber type. Select the COM port the Prober 

connection is using by clicking the Find button which will search available COM ports 

for the Access USB Prober. Alternatively, go to the Windows Control Panel, select 

System and select Device Manager. Locate the Ports settings as shown in the image 

below. Use the COM number shown next to “HS-20USB”.  

 

 

 

Check the Access (2) USB Grey Camera checkbox if you have an Access 2 Prober 

where the camera has a grey colored body rather than black. 

Click the Connect button to initiate communication with the selected hardware.  

 

Select the tab that is available for your oscilloscope model (i.e. DSO1022A). For most 

oscilloscopes, set the USB VID PID (vendor and product IDs), set the Port for USB, 

Connection to “None” and input the serial number of the oscilloscope being connected. 

Click the Connect button to connect with the oscilloscope. 
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Select the Sequence tab and uncheck the Enable Tracker checkbox and check the 

Enable (oscilloscope model) checkbox. Check the Enable Access DH checkbox if 

an Access DH Prober is being used. 

 

 

 

Select the Range tab and check the boxes to enable only Range 1. Set the Range 1 

Tester to your model of oscilloscope and the Range 1 Delay to 0. 
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Select the oscilloscope tab (for your model) on the Range Tab. The settings 

available in this tab may vary depending on the oscilloscope model used.  

You can set the plus and minus Tolerance amount, Measurement type, Scale V, 

Nominal measurement value and H Position. Tolerance is controlled by the 

Comparison setting at the Range level. It can be in measurement units (i.e. volts, etc.) 

or by percentage. These steps are simply setting defaults for when you add new 

components to the test. You can change the values in the Tree pane, Ranges tab at 

any time. 
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Click the Save (Permanent) button to save this configuration as the startup default. 

 

Using Workstation with an Oscilloscope 

An oscilloscope based test will typically use the concept of Test Points (TP). The 

Workstation Software has, for programming purposes, the concept of components and 

pins. When using an oscilloscope it is best to think of components as tests and pins as 

Test Points (TP). 

 

Creating a Oscilloscope Board Test 

There are a number of steps necessary to creating an oscilloscope board test.  

 

Huntron Workstation Test Layout (Tree)

Board (creates an Access .mdb file)

Sequence (test set of Tests) 

Component (Test)  (name, Functional Test)

Pins (TPs) (name; U1.6, TP3, etc.)

Ranges (Measurement settings)

 

 

Example of Board Test Information: 

Board Name: Sample (creates “Sample.hwdb” file) 

 Revision: (This field is optional) 

Sequence: Voltage Pk-Pk Measurements  

Component (Test): Test Points 

Pins (TP): Per TP settings for X, Y, Z locations, etc… 

Ranges: Per TP measurement settings, tolerance, etc… 
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The user has total discretion as to the information input into these fields. There is no 

“right” way as to what information is entered as every user’s situation will be different. 

The above example is just one way the information might be entered. 

Entering information into the entry windows is very straight forward. The easiest way 

to move from field to field is by pressing the TAB key. You can also use the mouse to 

click into a particular field so you can enter information. 

 

Test Building Procedures 

- Determine TP Locations on the board and the tests to be performed 

- Create Test Database in the Tree Pane 

o Add Board, Sequence, and Components (Tests)  

If an Access Prober is being used: 

- Perform Camera Offset 

- Select Alignment points  

- Teach component pin (TP) 

Using the test: 

- Scan Sequences and Set References 

 

Listed above is a general outline on how you would proceed when preparing to test a 

board. As with any type of complex test equipment, practice makes perfect so take the 

time to learn and practice these procedures. 
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Creating a Board Database 

 

 

To create a new Board, select New from the File menu or use the New button in the 

toolbar. Input information into the “Add New Board” dialog as needed. The only field 

that is required is board Name (Example “Sample”). Other fields such as Revision, 

System, Unit, Manufacturer and Gold Disk Number can be completed with related 

information if desired. 

Adding a New Sequence 

 

 

To add a new Sequence, select the Sequence tab in the Tree pane. Select Add New 

Sequence from the Edit menu or click the Add New button (+) in the toolbar. 
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Details: 

Sequence Name Field: Enter Sequence name 

Slot field: Select the Prober slot that the board will be in when scanning. 

Compare Priority: Selects the signature (or measurement) comparison priority 

between Same (serial number), All (serial numbers; this is the recommended setting) 

or Min/Max (Merged min/max signatures) 

The Delete Scans button will erase all scans for the current Sequence. 

Instructions field: Select the Instructions tab and enter any instructions or system 

information that you wish to pass on to future users. Note: the ENTER key in this field 

will work as a carriage return. 

For oscilloscope tests, select the Testers tab and check the Enable (model number) 

checkbox. Uncheck Enable Tracker if it is checked. 

 

Other functions within this window can be read by mousing over the item and viewing 

the Tool Tip or by clicking the HELP button. 

 

Adding a New Component (Test) 

 

To add a new Component (Test), select the Component tab in the Tree pane. Select 

Add New Component from the Edit menu or click Add New button (+) in the toolbar. 
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Details: 

Component Name field: Enter the component name (Test Name) in this field.  

Package and Number of Pins fields: The Number of Pins should be set to at least the 

number of TPs in this Test (component). Select more pins than the current number of 

TPs allows more TPs to be added later. For unused pins (TPs) uncheck the Scan Pin 

check box on the Pin Tab after the Component is created. 

Type field: This information is optional but you can enter the component type in this 

field.  

Pin Spacing: Not used with oscilloscope tests. 

Connection Type: Set to Prober for Access Prober users 

Open Check Type: Not used by with oscilloscope tests 

Pause checkbox: Sequence tests will pause at this component and display 

instructions 

Test checkbox: Enables or disables testing of the selected component 

Correction Steps: Sets the maximum amount of correction steps used with the 

Huntron Access Prober when moving to the first TP of the Test. 

Instructions field: Enter any instructions or component information that you wish to 

pass on to future users.  

Other functions within this window can be read about by clicking the HELP button. 
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Pin Edit 

Settings for individual pins can be modified by open the Pin Edit window. You can open 

the Pin Edit window by selecting the Pin tab in the Tree pane, right-click the row 

header and select Edit Pin. 

 
 

 

Name: Type directly into the Name field to change the pin name 

Net Name: Type directly into the Name field to change the Net name 

Correction Steps: Modifies the number correction steps used with Access Probers. 

This may need to be modified for very small pitch devices. 

Scan Pin: Enables or disables scanning of the selected pin 

Pause: Prober will pause and display Pin Instructions before scanning 

 

Modifying a Range (Oscilloscope Measurement Setup) 

When a new component (Test) is added to a Sequence default range(s) are added to 

each pin (TP). The defaults are set up in the Tools/Options/Range/(Oscilloscope 

model) tab. These settings need to be modified based on signal being measured at 

each TP. The goal is to obtain a good measurement at each TP. To stop after a failure 

of a particular measure it is best to use multiple Components (Tests) at the same XY 

coordinate each. The test only stops after a component (test) is completed. 
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To edit a Range, select the Range tab in the Tree pane. Select Edit Range from the 

Edit menu or the quick menu shown above. The Edit Range dialog will be displayed. 

The Tester drop menu shows the instrument used. 

 

 

Select the Tree/Range tab to 

display the ranges for the selected 

component pin. RIGHT click on 

the row header (far left grey area 

of the row) to display a quick 

menu (shown left) 
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Edit Range Details (settings may be different based on oscilloscope model): 

Note: All of the settings can be modified directly in the Range grid.  

+Tolerance: The amount above the Reference or Nominal Reading which determines 

the High Pass Limit. This is used during comparison to the value listed in the Nominal 

field. This amount can be a value or percentage depending on the Comparison setting. 

-Tolerance: The amount below the Reference or Nominal Reading which determines 

the Low Pass Limit. This is used during comparison to the value listed in the Nominal 

field. This amount can be a value or percentage depending on the Comparison setting. 

Measurement: Sets type of oscilloscope Measurement 

Scale V: Sets the scope Volts/Division 

Scale H: Sets the scope timebase 

Trigger Source: Sets Trigger source i.e. Chan. 1, Chan. 2, External, etc. 

Trigger Coupling: Sets Trigger coupling type i.e. AC, DC, etc. 

Comparison: Sets the comparison mode. Nominal compares the measurement to 

the entered Nominal value. Reference compares the measurement to the stored 

reference measurements. Nominal % uses the Tolerance setting as a percentage of 

the Nominal value. Reference % uses the Tolerance setting as a percentage of the 

Reference value. 

H and V Position: Enter the Vertical Position in divisions | Horizontal Position in 

seconds; leave blank to defaults 

Trigger: Enter the Trigger Level in volts | Trigger Holdoff in seconds | Trigger Slope 

(Rise, Fall, Both); Example: 1|0|Rise 

Channel: Enter the channel using channel name | coupling (DC, AC or GND). 

Example: CHAN1|DC 

Nominal: Enter the nominal value for the measurement. This is the value used when 

test Comparison is set to Nominal. 

BW 25M: Check for 25MHz bandwidth, uncheck for maximum bandwidth 

Trig Auto: Check to Trigger Auto, uncheck to Trigger Normal 

Invert: Check to Invert the signal, uncheck for normal signal 

Probe 1X: Check for 1X Probe, uncheck for 10X Probe 
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Mounting a PCB in an Access Prober 

Before software functions relating to an Access Prober can be performed, the PCB 

under test must be mounted into the Prober test area. Use the mounting accessories 

supplied with the Prober to securely mount your PCB by its edges. 

 

 

 

Refer to the Access Prober Users manual for more information on mounting a PCB. In 

some cases, a PCB holder is the best solution especially when the PCB cannot be easily 

mounted using the standard accessories. PCB holders are typically simple to construct 

and the only prerequisites are that the holder fit into the Prober and that it holds the 

PCB precisely at one of the designated Prober “Slots”. The Slots are referred to by the 

position in the Prober as TOP, MIDDLE, BOTTOM and BASE (Access 2 and Access DH 

only) and are set in the Sequence Edit window (see section “Adding a New 

Sequence”). 
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Prober Setup – Camera Offset part 1  

 

 

Performing the Camera Offset procedure is essential for the Prober to access test 

points accurately.  

Select the Offset tab in the Prober pane. 

Navigate the Camera to a target on the PCB. A very small target that is still visible by 

eye works best. Use the arrow buttons to move the camera the distance set in the 

travel distance field (directly below the arrow buttons). You can also click directly in 

the camera image to move the camera crosshairs to the clicked location. 

When the target is selected, press Set. 

Select Prober in the Mode drop menu to move to the next step. 

 

Prober Setup – Camera Offset part 2 
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Lower the probe tip down using the Z buttons until the probe just makes contact with 

the PCB. 

Visually examine the position of the probe tip; it should be located on the target 

selected in part 1 of Camera Offset, if not move on to the next step. Use a magnifying 

glass if necessary. 

Use the XY buttons to navigate the probe to the target selected in Part 1. The probe 

will lift when moving in the X or Y direction.  

When the probe is placed precisely on the target so it is just touching, press the Set 

and Save buttons to calculate the Offset values. 

 

Prober setup – Alignment part 1 

 

 

Alignment points that are positioned in opposite corners of the board work best. If the 

test was created using CAD data, the alignment points are pre-selected and you should 

proceed as described below however be aware that the Save button will not become 

enabled. Refer to the CAD Import tutorial for details on Alignment when creating a test 

from CAD data. 

Select the Align tab in the Prober pane. 

Select Alignment 1 from the drop menu. 

Select and navigate the camera to the first alignment point. Fiducial marks, small vias 

or traces with 90 degree bends work well for alignment points. 
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When the camera is set on the first alignment point press Set. 

The alignment point drop menu will select Alignment 2 automatically. 

Prober setup – Alignment part 2 

 

 

Make sure Alignment 2 is selected in the Alignment point drop field. 

Select and navigate the camera to the second alignment point. 

When the camera is set on the second alignment, press the Set button. 

 

The Auto Align feature will use image recognition to find and automatically center on 

the alignment point. Auto Align will only work after Align is performed manually the 

first time. 

 

Press the Save button to store the alignment points and the alignment point images. 
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Creating a Board Image 

 

 

For Prober users, the built-in color camera can be used to create a “mosaic” of the PCB 

by capturing images of the board and stitching them together. This is accomplished in 

the Image/Image Pane. The board must first be aligned before creating the image. 

Once aligned, you can use any camera view in the Prober pane to set the borders for 

image capture.  

Move the camera to the back right corner of the board. 

Press the Set Back Right button in the Image/Image Pane. 

Move the camera to the front left corner of the board. 

Press the Set Front Left button in the Image/Image Pane. 

Press the Create Image button to create the board image. 

 

Larger boards will require more time to create the board image. Once the board image 

is created, you can click a point on the board image and the Prober will move the 

camera to that point. 

Right-click on the image to display a menu to Delete, Copy or Save As the board 

image. 
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Prober setup – TP Teach – XY Setup  

 

 

Select the Teach tab in the Prober pane. 

Select the component to teach the Tree/Component pane. 

Select 1 in the Pin drop menu. 

Navigate the camera to the location of the first TP (Pin 1) (see image above). 

When the camera is set on the first TP, press the Save button. The Pin drop menu will 

increment to the next pin. 

 

Navigate the camera to the Location of the 2nd TP. 

When the camera is set on the 2nd TP, press the Save button. 

 

Continue setting the XY locations of all the TPs. 
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Prober setup – TP Component Teach Height (Z) 

 

Select the Teach Height tab in the Prober Pane. 

Select a Pin number in the Pin Z Down drop menu. This will position the probe tip at 

the selected TP. 

Use the Z Move buttons to lower the Z axis probe to the desired Sequence Up level. 

Make sure this level is high enough to clear tall components and chassis walls. This is 

the position the probe will lift to while probing a component. 

Press the Save button in the Sequence Z Up section to set the Sequence Up position. 

 

If desired, you can set an additional Up level for the component. This is the level that 

the probe will lift to when moving from one pin to the next. Use the Z Move buttons to 

move the probe down to the desired Component Up level. Make sure this level is high 

enough to clear the component package. Press the Save button in the Component Z 

Up section to set the Component Z Up position.  

 

The next step is to set the probe down position.  

Use the Z Move buttons to lower the probe tip to make contact with the component 

pin or pad. You may want to lower the probe in small increments once contact is made 

to slightly compress the spring probe and ensure good contact. Do this by changing 

the Z Travel distance setting. The signature of the contact point is displayed on the 

Preview tab of the Signature pane. Connect a common lead to the PCB if you see an 

open signature. 



 

© Huntron, Inc 2016 Rev. B 26 

Press the Save button in the Sequence Z Down section to set the Sequence Down 

level. This is the level the Prober will use when probing the component pins. 

If needed, you can also set Component Z Down and Pin Z Down levels for individual 

components and pins.  If the TPs of the component have varied heights, then use the 

Pin Z Down settings to modify the height position for each individual pin. Select the 

pin in the Pin drop menu, position the probe to the desired height and click the Save 

button in the Pin Z Down section.  

 

Manual Modes 

 

 

Manual measurements can be obtained using the (Oscilloscope model) tab in the 

Signature pane. This pane may be useful when configuring test parameters for a Test 

Point (TP). Setup the Measurement parameters and click Get Reading to capture and 

display a numeric measurement. Click Get Wave to capture and display the 

oscilloscope waveform. Click Hold Reading or Hold Wave to keep the reading or 

waveform displayed while capturing and displaying a second measurement.  
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Scanning a Sequence or Component 

 

 

Select the Sequence or Component to be scanned in the Tree Pane. 

Select the Scan tab in the Signature Pane (shown above). 

Input a Serial Number into the Serial Number field; this will be the name of the scan. 

The Stop On Failure check box will cause the scanning to stop if a component 

comparison fails. This is most useful when scanning known good boards to add as 

references. 

The Scan Continuous check box will cause the scan to go into a loop mode where it 

will scan without stopping until a signature comparison fails. 

Enable the Sequence checkbox to scan all of the components in the Sequence. 

The Use Scan List check box will add the ability to use a Scan List when the Scan 

Sequence dialog appears (see Creating a Scan List section). 

Press the Start button to execute the scan. 

The test instructions prompt will be displayed. Clicking OK will start the scan for 

probers. 

When a scan is complete, the results NO REF (NO Reference), PASSED or FAILED 

will be displayed (the text of the results message can be changed in the 

Tools/Options/General settings). The NO REF message will be displayed on the 

first scan of any test if the Comparison type is set for Reference or Reference % since 

there are no scans stored as Reference. If Comparison is set for Nominal or Nominal % 
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then the result will indicate PASSED or FAILED depending on how it compares to the 

Nominal value range setting.  

Clicking the Troublesheet button will display the signature differences in the 

Troublesheet tab of the Signature pane. 

 

Viewing Signatures – Troublesheet 

To view the Troublesheet, press the Troublesheet button in the Scan Results window. 

 

 

 

The current measurement, the measurement type, nominal value, tolerances, 

deviation and test result will be displayed in the signature box. 

If this is the first scan and you are using Reference Comparison setting then click the 

Set Reference button if this is a known good scan. 

When a scan is executed signatures are compared against the Nominal or Reference 

set (or sets) if it exists. To add the signatures in the Troublesheet as a Reference, 

press the Set Reference button (do this only with known good signatures). 

Signatures of the compared (Reference) signatures are displayed in contrasting colors. 

By default, the Reference signature is green and the failed signature is red. The 

Deviation (Dev) shown in the signature box is the amount that the measured value 

deviates from the Nominal or Reference value plus the tolerances set for the range. 
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If Set Reference is used, run the Scan again. A PASSED result should be indicated.  

 

Click the Troublesheet button to view the results. The Reference and Passed 

measurements will be displayed as well as the Deviation (Dev.) between the two. 

 

 

 

  



 

© Huntron, Inc 2016 Rev. B 30 

Viewing Signatures Troublesheet Report 

To view and print the Troublesheet report, press the Print button in the Troublesheet 

window. You can select from several options including a Sequence or Component Level 

report, the level of detail and add problem and solution comments to the report. Click 

Preview to view the report on-screen. 

 

    

 

 

The report can be printed or exported in several different formats including HTML and 

PDF by selecting File/Export Document in the Preview window. 
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Viewing Signatures in the Signatures Pane 

 

 

 

To view scanned signatures, select the Signatures tab in the Signature Pane. 

Signatures marked with an asterisk * indicate that this scan is set as a Reference. The 

Scan name, date and time will be displayed on the left side of the window and 

signatures on the right. The Scale buttons will change the number of columns 

displayed. Scaling the window will increase the number of signatures displayed. The 

Copy button will copy the signatures to the Windows clipboard so they can be pasted 

into another program (in a metafile format). The Print button will print the signatures 

in one of several different user selected formats. 
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Viewing Signatures – Right Click 

 

 

Additional options when viewing signatures can be displayed by right clicking in the 

signature area. 

Reprobe Pin Signatures: Gets Signature and prompts to replace the previous one 

Real Time: Updates measurement in real time 

Get Signature: Capture signature 

Replace Signature: Replaces the stored signature with the current signature 

displayed for the selected pin, range and scan (shown in the Scan List to the left) 

Replace Pin Signatures: Replaces the stored signatures with the current signatures 

displayed for the selected pin, all ranges and scan – works only in Range Mode 

 

Sync Pin/Range: Selects pin and range in the Tree (see default in Tools/Options) 

Edit Range: Selects the pin and range in the Tree and opens the Edit Range dialog 

Disable Range: Disables the selected range for the selected Pin  

Edit Pin: Selects the Pin the in the Tree and opens the Edit Pin dialog 

Teach Pin: Selects the pin the Prober Teach pane 

Teach Height Pin: Selects the pin the Prober Teach Height pane 

Group Edit: Opens Group Edit dialog for editing of component pin parameters as a 

group 

Net Edit: Opens Net Edit dialog for editing of Net pin parameters as a group 
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Sync CAD: Will link the selected signature to the CAD image displayed in the 

Image/CAD pane. Sync CAD will be disabled if there is no linked CAD data. 

Range/Pin Mode: Displays signature with Range priority or Pin priority; see default 

in Tools/Options). 

 

Component Scans Information 

 

 

Selecting the Component Scans tab in the Tree Pane will display all of the scans 

performed on the selected component in a table format. The Scan information 

displayed includes the serial number, operator, date/time, Merge setting (checked if 

this scan is included in the Merge set), Reference setting (checked indicates it is set as 

a comparison Reference), Pass status (will be checked if components passed 

comparison), Removed status (will be checked if component was removed from 

Troublesheet), Area number (highest of scanned pins), Deviation, Min/Max status and 

other settings (see Help for more information). 

 

Component Scans – Right Clicking (Auxiliary menus)  
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Right clicking on the Row bar of the Component Scans pane displays an additional 

menu for performing specific tasks such as deleting a scan for the selected 

components or all components. Enable Sequence Reference/Disable Sequence 

Reference will mark or unmark the selected scan as a reference (comparison) scan 

for all components in the Sequence. Delete Scan will erase the selected scan for the 

current component only. Delete Scan All Components/Nets will erase the selected 

scan for all components or nets in the Sequence. Load Troublesheet will display the 

selected scan in the Signature pane/Troublesheet tab. 

 

Component Scans – Right Clicking (Auxiliary menus)  

 

 

Right clicking on the Column bar of the Component Scans pane displays an additional 

menu for performing specific tasks such as sorting or globally setting parameters. The 

menu will vary depending on the column selected. In the image above, the Reference 

column header was right-clicked. 

 

Component Scans – Right Clicking (Auxiliary menus)  
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Right clicking on the Column bar of the Component Scans pane displays an additional 

menu for performing specific tasks such as sorting or globally updating items. In the 

image above, the Serial Number column header was right-clicked.  

 

Range Tab – Right-click Menu 

One very useful feature making quick global changes to range parameters is the menu 

available by right-clicking the column header (the title area directly above the column) 

in the Range tab. 

 

 

After making a parameter change for the range, right-click the column header for 

that parameter as shown in the image above to display the menu. The most useful 

selection is Set Current All/Pins where all of the pins of the component will be 

modified to the same setting as the selected Pin. This menu is available for most 

Range parameters. Remember to make the parameter change first then use Set 

Current All/Pins.  
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Sequence/Component/Pin Editing – Right Click menus  

 

 

Right clicking on the Row header bar of the Tree pane displays an additional menu for 

performing specific tasks such as Add New, Insert, Delete, Repeat, Build (repeat 

but with name incremented by 1), Copy, Paste and Cut. Right clicking works at all 

levels of the Tree pane including Sequence, Component (shown above), Pins, Ranges 

and Scans. The Sync CAD option available at the Component and Pin levels will 

synchronize the selected component or pin to the CAD image in the Image pane. 

It is also possible to select groups of components by holding the SHIFT or CTRL keys 

while selecting components in the Tree. To copy, paste, cut or delete groups of 

components, use the Copy, Paste, Cut or Delete Toolbar buttons below the main 

menu.  
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Pin Editing – Right Clicking (Auxiliary menus)  

 

 

Right clicking on the Row header bar of the Tree/Pins pane allows for editing of the pin 

information. Select Edit to open the Edit window for the selected pin. 

Note: Some Pin settings can also be edited directly in the Pins grid by clicking the 

appropriate field and modifying the setting.  

Group Edit and Net Edit allow you make changes to the pin of a component and have 

those modifications also change components that have the same number of pins within 

the same Sequence.   

 

 

 

 

Change the desired settings for the 

current Pin first then select Group 

Edit from the right-click menu (see 

above). Components with the same 

number of pins will be listed. Select 

the components and pins you want to 

be changed. Select the Pin Settings 

check box(s) for the setting(s) you 

want changed. Check the Ranges box 

to match the ranges (this will cause 

signatures to be deleted). Click the 

Update Pins/Ranges button to 
make the changes. 
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Huntron Workstation Buttons Feature 

Huntron Workstation has a built-in feature that allows any Windows based program to 

be started by clicking a button in the Workstation toolbar. It is very easy to use and a 

“Button” can be attached to any Board, Sequence or Component/Net. In this example, 

a Button will be created for a Sequence but the process is the same for the Board and 

Component/Net levels. 

To start, the Sequence edit window is opened by right-clicking the row header for the 

desired sequence. The Edit window will be displayed (see below). 

 

 

  

 

Select the Buttons… button located on the right side of the Sequence Edit window to 

open the Buttons Setup window. 
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To configure the Button, a Caption (button name displayed in the Tools menu), 

Command Line (the application to be run) and File Path (the file opened by the 

executed application) need to be input into the corresponding fields. A File path will 

not always be required such as instances where a browser is started and pointed to a 

specific URL. In this example, the button will be configured to start the Microsoft Paint 

application and open a small PCB image (see image below). If desired, the icon 

displayed in the main window toolbar can be set by browsing to and setting a path to 

an .ICO (icon) file in the Icon File Path field. Add text that will be displayed when the 

cursor is placed over the Button in Tooltip field. To make the linked file or icon stored 

as part of the Board database, check the Store File and/or Store Icon checkboxes. 
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Click OK to accept the Button. To create additional Buttons, repeat this process and 

click the Add New button in the Button Setup window. 

When Buttons are created, an additional toolbar will appear below the Huntron 

Workstation menu. This toolbar will change according to the level (board, sequence or 

component/net) selected. 

 

 

The icon shown can be replaced by selecting an appropriate icon in the Button Setup 

window (the default icon is shown). Click the toolbar button to execute the Button.  

 

Technical Support 

For questions or assistance in using Huntron Workstation, contact Huntron at  

800-426-9265, 425-743-3171 or email info@huntron.com. There is online assistance 

for Huntron Workstation at www.huntron.com/support/workstation.htm. This page will 

contains software updates, a form for reporting software issues and updates to 

documentation such as this tutorial. 

 

mailto:info@huntron.com
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